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Pur i t as  Sp r i ngs  So f twa re  

Three issues ago we pub-

lished a quiz for evaluating 

your computer skills level 

(Volume 2002, Issue 1. ñThe 

Weakest LinkðTesting 

Your Computer Literacyò). 

Youôll find a copy of the 

quiz at the News & Features 

section of our web site under 

the same title. The quiz can 

be used for two purposes. 

First, it helps focus office 

personnel on fundamental 

areas of computer use that 

may need improvement. Sec-

ond, it can be used as part of 

an employment application 

to evaluate the level of com-

puter proficiency of a pro-

spective  employee. 

 

As a follow-up to our quiz, 

two issues ago we published 

Lesson 1 of an instructional 

series (Volume 2004, Issue 

1. ñLesson 1ðIntroduction 

to Drives, Folders and 

Filesò). Lesson 1 discussed 

drives, folders and files in 

both specific and general 

terms, but space limitations 

prohibited us from giving 

step-by-step examples of the 

various procedures we con-

sidered basics of law office 

computingðnamely, copy-

ing, moving, deleting and 

renaming files. 

 

This issueôs lesson will give 

you the specifics for per-

forming these operations. 

Why are these skills so im-

portant? One reason is that in 

a mere decade the computer 

has nearly eliminated the use 

of the typewriter, made car-

bon paper extinct, and  made 

single-function photocopy 

machines obsolete. We all 

know that law offices are in 

the law business, not the 

computing business and 

therefore, law office person-

nel canôt be expected to be 

computer gurus, but the ex-

cuses for being computer 

illiterate are rapidly becom-

ing unacceptable. 

 

We want to do more than 

just call attention to the prob-
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L A W O F F I C E  CO M P U T I N G  

This hint is handy for starting your 
word processor (or any application 

for that matter) by simply pressing 
a key. Right-click your mouse on the 
icon or menu item you use to start 
your word processor. Select Proper-

ties from the pop-up menu. In the 
Properties dialog, go to the Shortcut 
tab and either click or tab to the 

Shortcut key field. When youõre in 
that field, you can select any short-
cut key or key combination (i.e.,  
<F5>). Donõt worry, if the shortcut 

you select is already in use, Win-
dows will modify your selection to 
avoid clashes. 

Shortcut To 

Your Word  

Processor 

With A Little Help  

From My Friends 
 

Weôve added an exciting 

new service to our library of 

existing legal and tax soft-

ware products. Itôs called 

Remote Assistance. With 

Remote Assistance we can 

visit your computer via the 

Internet and perform pro-

gram or computer mainte-

nance. Coupled with a simul-

taneous phone call, Remote 

Assistance has proved excel-

lent for giving one-on-one 

lessons in using our pro-

grams. Think of it as GoTo-

MyPC in reverse. If youôre 

computer illiterate, think 

of it as obtaining a degree 

in law office computing. 

Weôll make you an expert in 

no time at all. 

 

At the time of this writing, 

our experience with this new 

technology is limited, but in 

a very short time Remote 

Assistance has been tre-

mendous for performing 

network diagnostics. Al-

ready in a number of in-

stances, our users have told 

us that a simple 20-minute 

session saved their office 

hundreds of dollars in on-site 

technical assistance charges.  

(Continued on page 3) 
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see how this instruction 

changed by the time Win-

dows XP was released. No-

tice how the emphasis has 

changed to saving files in the 

My Documents folder in 

order to avoid navigational 

issues. Microsoft goes one 

step farther in this avoidance 

by recommending the use of 

the Search command to find 

the target file if itôs not in the 

My Documents folder. This 

sidestep doesnôt help much 

because weôve found the 

Search command a bit 

harder for beginners to use 

than the earlier Find com-

mand used in previous ver-

sions of Windows. 

 

Here are the steps: 

 

1. Open My Documents. If 

the file or folder you want 

to copy is not located in 

My Documents or its sub-

folders, use Search to find 

it. To open Search, click 

Start, and then click 

Search. 

2. Click the file or folder you 

want to copy.  

3. Under File and Folder 

Tasks, click Copy this file 

or Copy this folder.  

4. In Copy Items, select the 

drive or folder you want to 

copy to, and then click 

Copy.  

 

Thatôs it. If you follow those 

steps you should be able to 

copy any file or folder to any 

other location. The copy/

paste functionality is hardly 

different from what youôre 

used to doing in a word proc-

essor.  

 

Finally there are a few other 

things you should note about 

the Copy command.  

 

lem. Weôd like to be part of 

the solution. So, the series 

continues with this demon-

stration of some of the file 

handling and housekeeping 

basicsðcopying, moving, 

renaming, and deleting files. 

 

Windows Explorer 

 

Regardless of the task, al-

most everything that you do 

in connection with files and 

folders requires that you 

know how to start and oper-

ate Windows Explorer. Les-

son 1 covered starting and 

navigating Windows Ex-

plorer in enough detail that 

weôll assume you know how 

to do it. Your ability to start 

and move around in Win-

dows Explorer is crucial to 

proceeding through this les-

son. If youôre unfamiliar, go 

to our web site and take a 

look at the Windows Ex-

plorer section of Lesson 1. 

 

Copying 

 

The help topic from Win-

dows 2000 has one of the 

best step-by-step examples 

of how to copy files. Here it 

is: 

 

1. Open Windows Explorer.  

2. Click the drive or folder 

you want to work with.  

3. Click the file or folder you 

want to copy or move.  

4. On the Edit  menu, click 

Copy. 

5. Open the folder or disk 

where you want to copy 

the item.  

6. On the Edit  menu, click 

Paste.  

 

Steps 2 and 3 are the ones 

that seem to bugger novice 

users, so itôs interesting to 

(Continued from page 1) 
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When this satellite imagery software 

was first available it, was $300. Now 
that Google purchased the rights, 
itõs free. Once you download and 

install the software, called Google 
Earth, it letõs you view a satellite 
image of the earth. Thatõs cool, but 
Google Earth goes quite a bit fur-

ther by letting you zoom in to a 
surprising extent. You can, for ex-
ample, easily find your street and 
home. So aside from amusing your-

self by visiting places of interest, 
you might find this software useful 

for vicariously visiting the scene of 

an accident. It might also be possi-
ble to validate certain aspects of a 
witnessõs testimony relating to 
directions or distance. We 

downloaded a Version 4 beta copy 
(Version 3 is the current version at 
the time of this writing). Version 4 

permitted us to tilt the image in a 
third plane which provided another 
interesting and potentially useful 
point of view. Try it, itõs free. 

Google 

Earth 

Hereõs a diagnostic trick that 
shouldnõt be overlooked. While 
giving technical support to our 

customers, it sometimes happens 
that a user gets an error number or 
message that we never heard of. 
When a company distributes and 

supports software over thousands 
of systems, it still encounters 
unique problems that are rare but 

still regular occurrences. Of course, 
weõve got countless manuals, books 
and trade publications to use as 
resources for problem solving, but 

guess what has become a first 
choice in many instances? Google! 
Thatõs right. If your search is well 
constructed youõre likely to find the 

answer in Google. For example, at 
least three or so times a year we 
encounter users getting an error 

message saying the application (our 
program) they were trying to run 
was not a 32-bit application. It 
doesnõt matter whether you know 

what 32-bit applications are. It does 
matter, however, that Puritas 
Springs Software applications are all 

32-bit Windows applications. Conse-
quently, this error message was 
obviously incorrect. The first step in 
our detective work was to take a 

unique snatch of the error message 
text and Google it. Our first search 
yielded 45 million hits. On further 

refinement we narrowed it down to a 
few thousand, the first of which was 
òôWINNT32.EXE is not a valid Win32 
applicationõ error message when 

éó . The extracted text description 
made the web page sound like a 
relevant hit, so we wanted to learn 
what we could about the source. 

Naturally, òwww.getvirushere.comó 
is going to be a suspect source. The 
web page in our example bore the 

address: 
òwww.support.microsoft.com.ó 
Things are looking pretty good at 
that point. The Knowledge Base 

article referred to by the Google link 
mentioned that this can happen on 
64-bit Windows systems when they 

try to run 32-bit programs. The 
recommended solution worked in 
each case.  
 

 
 
 

Using 

Doctor 

Google 

¶ The command works on 

folders as well as files 

¶ To select consecutive files 

or folders to copy, click 

the first item, press and 

hold down SHIFT, and 

then click the last item. 
¶ To select files or folders 

that are not consecutive, 

press and hold down 

CTRL, and then click each 

item. 
 

Moving 

 

Moving is the same as copy-

ing with the exception that at 

the end of the operation the 

file no longer exists in the 

original locationðbecause 

youôve moved it! Otherwise 

itôs the same as the Copy 

(Continued on page 3) 
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COPYING ,  M OVING ,  RENAMING  & 
D ELETING  

Special 

Pasting  

Info  

folder from one window to 

the other. 

 

Renaming 

 

Changing the name of a file 

or folder might be the easiest 

of all the procedures we are 

covering in this article. As 

usual, the process begins by 

navigating to the file in Win-

dows Explorer. Here are the 

steps recommended by Mi-

crosoft. 

 

1. Open Windows Explorer.  

2. Click the file or folder you 

want to rename.  

3. On the File menu, click 

Rename.  

4. Type the new name, and 

then press <ENTER>.  

 

Other things to note about 

the Rename command are: 

 

¶ You do not need to open 

the file or folder to rename 

it.  

¶ You may find it easier to 

simple press the <F2> key 

once youôve highlighted 

the name of the file you 

want to change. 

¶ A file name can contain up 

to 215 characters, includ-

ing spaces. However, it is 

not recommended that you 

create file names with 215 

characters. Most programs 

cannot interpret extremely 

long  file names. The Bor-

land Database Engine, for 

example, has a 64 charac-

ter file name limitation. 

¶ File names cannot contain 

the following characters: 

\ / : * ? " < > | . 

¶ You can also rename a file 

or folder by right-clicking 

it and then clicking Re-

name from the pop-up 

menu. 

¶ The name of system fold-

ers such as Documents 

and Settings, WinNT , or 

System32 cannot be 

changed because they are 

required for Windows to 

run properly. 

 

Deleting 

 

If youôve stepped through 

the first three functions you 

should be noticing that the 

procedures are very similar. 

For beginners, the hard part 

is not executing the com-

mand, but starting and navi-

gating in Windows Explorer. 

 

That being said, it should 

come as no surprise that 

starting Windows Explorer 

and navigating to the desired 

file is again the first step in 

Microsoftôs instructions: 

 

1. Open Windows Explorer.  

2. Click the file or folder you 

want to delete.  

3. On the Edit menu, click 

Delete.  

 

Other points of note are: 

 

¶ For touch typists who like 

to do things the quickest 

way possible, try high-

lighting the desired file 

and simply hitting the 

<Delete> key on your key-

board. 

¶ Deleted files remain in the 

Recycle Bin until you 

empty it. 

¶ Holding down the <Shift> 

while deleting a file will 

skip the Recycle Bin and 

permanently remove the 

file. 

¶ If you want to retrieve a 

file you have deleted, dou-

ble-click Recycle Bin icon 

on the desktop, right-click 

command. The only differ-

ence is that instead of select-

ing the Copy command (on 

the Edit menu), use the Cut 

command (in pre-Windows 

XP systems) or the Move é 

command (in Windows XP). 

In all other respects these 

commands are identical. 

 

Pre-Windows XP 

 

1. Open Windows Explorer.  

2. Click the drive or folder 

you want to work with.  

3. Click the file or folder you 

want to move.  

4. On the Edit  menu, click 

Cut to move the item.  

5. Open the folder or disk 

where you want to move 

the item.  

6. On the Edit  menu, click 

Paste.  

 

Windows XP 

 

1. Open My Documents. If 

the file or folder you want 

to move is not located in 

My Documents or its sub-

folders, use Search to find 

it. To open Search, click 

Start, and then click 

Search. 

2. Click the file or folder you 

want to move.  

3. Under File and Folder 

Tasks, click Move this 

file or Move this folder. 

4. In Move Items, click the 

new location for the file or 

folder, and then click 

Move. 

 

Note that you can also move 

a file or folder by dragging it 

to the desired location. In 

most instances, the new loca-

tion is remote and therefore 

youôll need to open two in-

stances of Windows Explorer 

and drag the target file or 

(Continued from page 2) 

 

Remote Assistance can be 

used very effectively for 

one-on-one tutoring be-

cause a user can watch and 

learn on their own computer. 

Itôs an effective tool for an-

swering questions and for 

demonstrating all levels of 

program use from simple 

(i.e., batch printing) to ad-

vanced (i.e., modifying tem-

plates). It should be obvious 

that law offices save count-

less hours (and money) by 

performing their work cor-

rectly and quickly. 

 

If you're interested call us at 

your convenience. Please try 

to schedule Remote Assis-

tance sessions at least one 

day in advance. Sessions are 

$30.00 per half hour session. 

Youôll be amazed at what 

can be covered in one ses-

sion. 

(Continued from page 1) 

the file you want to re-

trieve, and then click Re-

store. 

¶ You can also delete files 

by right-clicking the file or 

folder and then clicking 

the Delete command on 

the pop-up or context 

menu. 

¶ Finally, as you are proba-

bly already aware, you can 

delete files as well as fold-

ers. 

 

If you previously counted 

yourself as a computer illit-

erate, that label no longer 

applies to you. Lessons 1 and 

2 should provide you with 

the rudiments you need to 

work in a law office. Re-

member, thereôs more to life 

than word processing. Still 

unsure of yourself? One Re-

mote Assistance session and 

weôll have you doing this in 

your sleep. See ñWith A Lit-

tle Help From My Friendsò 

on page 1. 
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Too Many Tips, 

So Little Space 

 

There were so many great 

computer tips to pass along 

that we ran out of space in 

the side bars and decided to 

put the balance of them here. 

If all goes as expected, our 

usual Digital Inklings rants 

and raves will return next 

issue. 

 

While I Was Out 

 

Did you ever send an email 

and get an immediate re-

sponse saying so and so is 

out of the office and wonôt 

return until such and such 

time? Donôt you wish you 

could do that? Itôs like hav-

ing permission to ignore the 

email you got while you 

were on vacation. The alter-

native is sifting through hun-

dreds of messages when you 

get back. If you use Micro-

softôs Outlook, hereôs how 

you do it. 

 

1. Make a Template. Create 

an email just as you would 

any email message. Give it a 

subject line along with the 

message you want as the 

body text and save it. When 

youôre in the Save As dialog 

box, youôll notice that you 

can pull down the File Type 

box and select Template. 

When you do, the email will 

be saved in the designated 

template folder and given an 

oft extension. 

 

2. Create a Rule. Use Out-

lookôs Rules Wizard on the 

Tools menu. Complete the 

following series of steps in 

the Rules Wizard. 

 

A. On page 1 of the Wizard, 

click on the New button. 

D IG ITAL  

B. Of the available rule types 

on page 2 of the Wizard, 

select Check messages 

when they arrive. Click on 

the Next button. 

 

C. On the Conditions page, 

select When received 

through the specified ac-

count. Before clicking the 

Next button click on the 

specified account text at the 

bottom of the dialog and 

select the account to which 

you wish to apply this rule. If 

youôre the only one using the 

computer, there may be only 

one accountðyours. 

 

D. On the What do you 

want to do é page, select 

Reply using a specific tem-

plate. Again, you must clar-

ify your choice by clicking 

on specific template at the 

bottom of the dialog. Choose 

the template you saved in 

step 1 above. Usually youôll 

need to pull down the Look 

In box at the top of the dia-

log and select User Tem-

plates instead of Standard 

Templates. Click on the 

Next button. 

 

E. The next dialog page asks 

whether you wish to create 

any exceptions to the rule. 

You could, for instance, cre-

ate an exception for emails 

from your mother. In our 

example here donôt select 

any of the exceptions and 

just click on the Next button. 

 

F. The final page of the 

Rules Wizard dialog asks 

you to give your rule a name. 

You might choose While I 

Was Out. It doesnôt matter 

so long as you can identify 

the rule when you need it. 

Then click the Finish button 

and youôre done. 

So now youôve got a rule 

that is applied to emails 

when they come in. It replies 

to any incoming emails using 

the template you created. 

Thereôs one more step. You  

need to turn the rule off and 

on.  

 

When youôre ready to go on 

vacation and you want to use 

the rule, click on the Rules 

Wizard item on the Tools 

menu. This time you should 

see your rule (with the name 

you created for it, i.e., While 

I Was Out, at the top of the 

dialog along with any other 

rules that might have been 

created. Simply put a check 

in the checkbox to the left of 

the rule. Then click on the 

Ok button. Youôre good! 

Just donôt forget to turn the 

rule off when you get back 

from vacation! 

 

While Weôre At It 

 

While weôre on the subject 

of the Rules Wizard, weôd 

like to give you some idea of 

what the Wizard is capable 

of. Hereôs a list of the types 

of rules available: 

 
¶ Check messages when they 

arrive 

¶ Check messages after sending 

¶ Move new messages from 
someone 

¶ Notify me when important 
messages arrive 

¶ Move messages based on 
content 

¶ Delete a conversation 

¶ Flag messages from someone 

¶ Assign categories to sent 
messages 

¶ Assign categories based on 
content 

¶ Move messages I send to 
someone 

(Continued on page 5) 

No doubt if you do a considerable 
amount of word processing there 

have been times when you wanted 
to select (or highlight) a portion of 
text. When you clicked and dragged 

over the desired text, the highlight 
automatically selected the entire 
word instead of just the part that 
you wanted. If you find that this 

behavior is not usually what you 
want, there is a little-known editing 
option you can set to defeat it. Here 

are the steps for turning automatic 

word selection off: 
 
1. In Microsoft Word, click on the 

Tools menu and select the 
Options submenu. 

2. When the Options dialog ap-

pears, go to the Edit tab. 

3. On the Edit page, remove the 
check from the checkbox la-
beled When selecting, auto-

matically select the entire 
word.  

Selecting 

Text in 

Word 

Dignify  

Yourself 

You can give your letters and other 
documents a polished, professional 

look by adding a watermark. If 
youõre unfamiliar, a watermark is a 
graphic that has a high degree of 

transparency and functions as a 
background for printed matter. In 
Microsoft Word, select the Format 
menu, then Background, then 

Printed Watermark. In the resulting 
dialog, select either Picture water-
mark or Text watermark. The Picture 
watermark choice lets you select a 

picture from a file on your hard 
drive. If you can access a graphic 
library, youõll probably find some-

thing suitable.  We located a pretty 
sizable collection of artwork at: 
c:\Program Files\Microsoft Of-
fice\Clipart\Pub60Cor. Be prepared 

to use some type of graphic viewer 
in order to find a decent piece of 
artwork. 
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¶ Stop processing all following 
rules. 

 

The next parameter to be set 

is the conditions that apply. 

Here are your choices. 

 
¶ When received through the 

specified account 

¶ Where my name is in the To 
box 

¶ Sent only to me 

¶ Where my name is in the CC 
box 

¶ Where my name is in the To 
or CC box 

¶ Where my name is not in the 
To box 

¶ From people or distribution 
list 

¶ Sent to people or distribution 
list 

¶ With specific words in the 
recipientõs address 

¶ With specific words in the 
senderõs address 

¶ With specific words in the 
subject 

¶ With specific words in the 
body 

¶ With specific words in the 
subject or body 

¶ With specific words in the 
message header 

¶ Flagged for action 

¶ Marked as important 

¶ Marked as sensitivity 

¶ Assigned to a category 

¶ Which is an Out of Office mes-
sage 

¶ Which has an attachment 

¶ With selected properties of 
documents or forms 

¶ With a size in a specific range 

¶ Received in a specific date 
range 

¶ Uses the form name form 

¶ Suspected to be junk email or 
from Junk Senders 

¶ Containing adult content or 
from Adult Senders 

Text you see underlined in 

the foregoing and subsequent 

(Continued from page 4) lists must be clicked on and 

specified. In other words, 

When received through the 

specified account requires 

that you specify the account. 

Usually you will click on the 

underlined text and then se-

lect from the available 

choices. 

 

CAVEAT. Donôt expect too 

much from the Junk and 

Adult Senders rules. Most 

spammers continually use 

different, fictitious sending 

addresses, so these rules 

donôt work too well under 

these circumstances. 

 

Okay, youôve told the Rules 

Wizard  what type of rule 

youôre creating and when to 

apply the rule. The next page 

of the Wizard asks you what 

you want to do when a par-

ticular email meets these 

conditions. Here are your 

choices: 

 
¶ Move it to the specified folder 

¶ Move a copy to the specified 
folder 

¶ Delete it 

¶ Permanently delete it 

¶ Forward it to people or distri-
bution list 

¶ Forward it to people or distri-
bution list as an attachment 

¶ Print it 

¶ Reply using a specific tem-
plate 

¶ Notify me using a specific 
message 

¶ Flag message for action in a 
number of days 

¶ Clear the Message flag 

¶ Assign it to the category cate-
gory 

¶ Play a sound 

¶ Start an application 

¶ Mark it as importance 
¶ Perform a custom action 

I NKLINGS  

¶ Stop processing more rules 

 

The next page of the Wizard 

has a list of exceptions that is 

too lengthy to reproduce here 

in its entirety. Below are a 

few of the more potentially 

useful exceptions you can 

apply. As you can guess, 

exceptions are used when the 

condition(s) of a rule apply, 

i.e., the email was received 

during a particular date range 

you had chosen to block in-

coming emails, BUT, you 

want momôs email to be an 

exception to the rule. 

 
¶ Except if sent directly to me 

¶ Except if sent only to me 

¶ Except where my name is in 
the CC box 

¶ Except if my name is in the To 
or CC box 

¶ Except where my name is not 
in the To box 

¶ Except if from people or dis-
tribution list 

¶ Except if sent to people or 
distribution list 

¶ Except when received through 
the specified account 

¶ Except with specific words in 
the recipientõs address 

¶ Except with specific words in 
the senderõs address 

¶ Except if the subject contains 
specific words 

¶ Except if the body contains 
specific words 

 

You can see that most any 

exception you can think of is 

covered in this list. Hope-

fully youôll find that the 

Rules Wizard is a powerful 

email management tool. And 

it doesnôt hurt that itôs free 

too! 

Although other browsers already 

had this feature, if youõre using 
Microsoftõs Internet Explorer as your 
web browser, youõll want to make 
sure youõve upgraded to version 6 

and that youõve enabled tabbed 
browsing. Whatõs tabbed browsing 
you ask? If you ask us, itõs one of 

the biggest and best enhancements 
to Internet Explorer in recent his-
tory. Weõre all familiar with normal 
browsing: you visit a site, the page 

appears in your browser, then you 

visit another site and a new page 
appears in your browser. In the 
course of surfing the web you may 

go back to a previous site or flip 
back and forth comparing two sites. 
This surfing method has its obvious 

drawbacks. Tabbed browsing, by 
contrast, lets you keep multiple 
sites open in your browser in much 
the same way that you can keep 

multiple documents open in your 
word processor. A row of tabs along 
the top of Internet Explorer  has the 

names of all the open sites and all 
you do is click on the appropriate 
tab to go from one to the other. You 
can still browse like you used to, 

but when you want to keep a page 
handy, you can visit new sites via a 
new tab. This is especially helpful 
for sites that donõt permit paging 

back which is often the case with 
secure pages. 
 

On one of our computers Internet 
Explorer set itself for tabbed brows-
ing automatically when we up-
graded. On another computer we 

had to enable it manually. Hereõs 
how we did it. Assuming you have 
Version 6, and you have the MSN 

toolbar installed, click on the MSN 
toolbar button and a menu will drop 

down. Select the item labeled MSN 
Search Toolbar Options é When 

the MSN Search Toolbar Options 
dialog appears expand the Toolbar 
key in the tree view and click on the 

Tabbed Browsing key. When you do, 
youõll see the Tabbed Browsing 
options to the right. Click, that is 
place a checkmark, in the checkbox 

labeled Turn on tabbed browsing. 
Click on the OK button and youõre all 
set. 

Keeping 

Tabs On  

IE6 

Law Of f ice Comput ing Page 5 
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FAMILY  L AW 
PRACTIT IONER õS APPRENTICE  

Mrs. Jones, youôve got a 
lovely son, - er, daughter  
 
If youôve taken the first step 
towards automating your 
family law practice, you may 
have word processing docu-
ments that you use as tem-
plates to generate Separation 
Agreements or Judgment 
Entries. Thatôs better than 
having no templates, but it 
has several drawbacks. 
 
One drawback is that 
changes related to gender 
and number can be difficult to 
track. For instance, have you 
ever reviewed a document at 
court and noticed an embar-
rassing, typographical error, 
like referring to the husband 
as ñshe?ò Or making a refer-
ence to ñchildrenò when the 
parties have only one child? 
Over the years, proofreading 
these familiar documents 
becomes increasingly difficult 
as constant, repeated expo-
sure makes errors harder to 
spot. 
 
Another drawback relates to 
global variablesðthat is, 
information that remains con-
stant from one document to 
the next in the same case 
(for example, the case num-
ber, the partiesô names and 
addresses, and a host of 
other items). With FLPA , 
from the initial complaint to 
the final judgment entry, 
youôre never required to re-
enter information from one 
document to the next.   
 
FLPA handles these issues 
by having you make one-time 
selections as to the gender of 
the parties and then FLPA 
consistently changes all the 
nouns, pronouns, verbs and 
adjectives to agree with your 
selections. Other basic infor-
mation is handled the same 
way. Global variables are 
administered globally. 
In other words, once you 
enter the partiesô names and 

case number in the work-
sheet, the information popu-
lates all the forms and plead-
ings automatically. Format-
ting and typing captions will 
be a thing of the past. You 
enter repetitive information 
once! When itôs correct the 
first time, you save time . 
No more brainless grammati-
cal errors in an otherwise 
perfect document. 
 
Going Global  
 
The faster you can generate 
perfect documents, the more 
you save in case preparation 
time and staff time. Thatôs 
why we give you the added 
ability to (1) set global de-
faults via our DEFAULT.FLP 
file and (2) modify the pro-
gram templates to customize 
documents for your specific 
uses. So, if you have certain, 
personalized, provisions in a 
particular document, you 
could alter the corresponding 
document template to include 
your specific languageð
permanently. 
 
Speed Thrills  
 
The whole point of FLPA is 
to produce better docu-
ments faster. Itôs especially 
user-friendly to law offices. 
Why law offices? Because 
they are emergency rooms 
for the treatment of legal 
problemsðyouôre meeting 
deadlines, locating wit-
nesses, taking depositions, 
interviewing clients, and the 
list goes on. Typical law of-
fices do not have the luxury 
of lazy afternoons with noth-
ing to do. There is simply no 
time to work on improving 
computer skills. But while the 
typical law office computer 
user may be computer illiter-
ate, they are usually word 
processor wise! Why not? 
Documents are a law officeôs 
stock-in-trade.

Feature List  
 

X In addition to completing 

all the documents listed in 
the shaded box to the left, 
FLPA produces sets of 
blank worksheets that 
can be given to clients 
for completion .  

 

X FLPA is a trial prepara-

tion tool that can organize 
and print marital assets, 
marital debts, income 
information, living ex-
penses, and more. 

 

X FLPA works seamlessly 

with any Windows word 
processor capable of 
opening RTF files, includ-
ing Microsoftôs Word for 
Windows and Corelôs 
WordPerfect. 

 

X FLPA works in all 32-bit 

Windows systems and is 
available in network 

versions . 
 

X For more information 

and features, visit the 
product information page 
of our web site. 

Document Index 
 

2 Answer 

2 Arrearages, Agreed Motion to 

Correct 

2 Arrearages, Judgment Entry 

on Motion to Correct 
2 Bond, Judgment Entry - Order 

to Post 

2 Child Support, Motion to 

Modify 

2 Continuance, Judgment Entry 

on Motion for 

2 Continuance, Motion for 

2 Counterclaim 

2 Dissolution of Marriage, 

Judgment Entry on Petition 

for 

2 Dissolution of Marriage, 

Petition for 

2 Divorce, Complaint for 

2 Divorce, Judgment Entry on 

Complaint for 

2 General Information 

2 Health Insurance 

Investigation Form 

2 Motion for Specific Acts 

2 Parental Rights and 

Responsibilities, Motion to 

Modify Allocation of  
2 Pretrial Statement 

2 Relocate, Notice of Intent to 

2 Residential Parent, Affidavit of 

2 Restraining Order, Motion & 

Affidavit for Temporary 

2 Restraining Order, Temporary 

2 Separation Agreement 

2 Shared Parenting Agreement 

2 Show Cause, Motion to 

2 Standard Visitation Guidelines 

2 Support Pendente Lite, 

Answer to Motion for 

2 Support Pendente Lite, 

Financial Disclosure Affidavit 

2 Support Pendente Lite, 

Motion for, with Notice 

2 Temporary Custody, Motion 

for 

2 Withholding, Judgment Entry - 

Order to Terminate 

F R E E  D E M O  
A V A I L A B L E  

SE E  PA G E  3 5 

In Good Humor  

Definitions 

 
Coffee (n) - the person upon whom 

one coughs. 
 
Flabbergasted (adj) - appalled over 
how much weight you have gained 

since you began your new diet. 
 
Abdicate (v) - to give up all hope of 

ever having a flat stomach. 
 
Esplanade (v) - to attempt an expla-
nation while intoxicated. 

 
Willy-nilly (adj) - one who is impo-
tent. 
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GENERAL INFORMATION WORKSHEET  
  
 

Wife- 
Last Name:  First Name:  Initial:  
Address Line 1:  
Address Line 2:  
City:  County:  State:  Zip Code:  
Phone No.:  Drivers License No.:  
Date of Birth:  Social Security No:  
Number of Marriages:  
Has Wife been a Resident of Ohio for more than 6 months?  Ç Yes   Ç No 
Has Wife been a Resident of County for more than 90 days? Ç Yes   Ç No 

  
 

Husband - 
Last Name:  First Name:  Initial:  
Address Line 1:  
Address Line 2:  
City:  County:  State:  Zip Code:  
Phone No.:  Drivers License No.:  
Date of Birth:  Social Security No:  
Number of Marriages:  
Has Husband been a Resident of Ohio for more than 6 months?  Ç Yes   Ç No 
Has Husband been a Resident of County for more than 90 days? Ç Yes   Ç No 

  
 

Opposing Party's Attorney - 
Name:  
Address Line 1:  
Address Line 2:  
City:  State:  Zip Code:  
Phone No.:  Supreme Court Registration No.:  

  
 

Marriage Information - 
Date of Marriage:  Place of Marriage:  

  

These screen shots and sample printout will give you an idea of how easily 
FLPA can generate perfect documents. If youôre preparing the divorce 
complaint, you simply choose the grounds in the dialog shown above. 
Above left, you select the method of service by simply clicking your mouse. 
Left, youôre filing an answer to a complaint. Just pick your affirmative de-
fenses from the list. FLPA automatically includes cites to the statutes and 
civil rules. 

Law Of f ice Comput ing Page 7 
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OHIO  SPOUSAL SUPPORT  

What Does MA_200X Do? 

 

MA_200X is a tool for 

calculating spousal support, 

addressing tax issues, ana-

lyzing family budgets, calcu-

lating child support and test-

ing property division 

schemes. The child support 

software incorporated in 

MA_200X is the same as in 

our WROCSG with some 

additions. But the big change 

in MA_200X is not about 

child support or taxesðitôs 

about spousal support. 

 

Spousal Support/Alimony 

 

ORC §3105.18(B) lists 11 

factors that a trial court must 

consider in determining 

spousal support. Following 

these guidelines, MA_200X 

provides a range of 

recommended spousal 

support figures that is not 

simply the result of a tax 

analysis or income 

equalization formula. You 

can review the results and 

methodology by viewing the 

forms in the Spousal 
Support section. It links you 

to  the four items below. 

 

1. Income, Taxes, Support 
& Expenses 

 

A side-by-side summary of 

the partiesô taxable and 

nontaxable income along 

with personal and living 

expenses (essential and non-

essential). Both before-tax 

and after-tax information is 

provided with the currently-

set amount of spousal 

support. See Page 9.  

 

2. Support v. Lifestyle 
 

Summarizes the information 

contained in the Income, 

Taxes, Support & 
Expenses form through a 

range of 28 different values 

of spousal support. We call 

it the Lifestyle form because 

it provides an instructive 

comparison of each partyôs 

ability to meet essential and 

nonessential living expenses 

at different levels of spousal 

support. Youôll find this 

form to be one of  

MA_200Xôs most telling 

reports. See Page 9. 

 

3. ReportðStatutory Con-
siderations 
 

Too long to be duplicated 

here, itôs written in a style 

that is more like a legal brief 

or judgment entry than an 

accounting spreadsheet. It 

begins by finding the differ-

ence between the partiesô 

respective total incomes. 

Each partyôs income is then 

adjusted for payment of 

federal, state and local 

income taxes in order to at-

tain a more realistic starting 

point for comparing after-tax 

income and each partyôs 

ability to meet their personal 

and living expenses (i.e., 

maintain their lifestyle). 

 

In cases where spendable 

income doesnôt meet living 

expenses. MA_200X goes 

one step farther by distin-

guishing between essential 

and nonessential expenses. 

Why? Because division of 

the family unit necessarily 

involves the financial hard-

ship related to supporting 

two households on the same 

income that previously 

supported one. In that con-

text, categorizing expenses 

as essential or nonessential 

assumes increased impor-

tance. 

A sample of this report is on 

the Demos & Downloads 

page of our web site. 
 

4. Set Spousal Support 
 

This form lets you deviate 

from any formulas or algo-

rithms and set your own 

amount to be used in the tax 

calculations and expense 

comparisons. In the end, itôs 

you in control of the calcu-

lation and not the other 

way around. 

 

Child Support & Taxes 

 

Donôt forget that MA_200X 

includes complete child sup-

port guidelines software. At 

the same time, all calcula-

tions are after-tax figures. 

That means the tax conse-

quences involved in the ex-

change of support are auto-

matically incorporated into 

forms such as the Lifestyle 
form. From the Tax Issues 

section of MA_200X you can 

view or print a breakdown of 

tax information related to 

who should take the depend-

ency exemptions and how it 

affects both parties. When 

itôs best to split the depend-

ency exemptions, MA_200X 

lets you know in the Child 
Dependency Exemptions 
vs. Taxes form. 

 

MA_200X also prints side-by

-side tax form facsimiles for 

both parties so you can ver-

ify the tax ramifications 

every step of the way. 

 

All forms and reports are 

capable of being exported 

to your word processor for 

quick and easy inclusion in 

your word processing 

documents.  

If youõre getting more and more emails 
these days, you might find itõs easier 
to spot special or desirable emails by 

having Microsoft Outlook color code 
incoming emails. Outlook allows you to 
set the color by following these steps: 

 

1. Click on the Tools menu and select 
Organize. 

2. A new window pane will appear in 

Outlook that has the captionñ
Ways to Organizeé. 

3. In the Ways to Organize window, 
select the button labeled Using 

Colors. 

4. Depending on what folder is active, 
i.e.,  Inbox, and what email is se-

lected, you can apply a color to that 
sender by simply choosing a color 
from the drop-down color list. 

Now any emails in the Inbox from that 

person and any future emails from that 
person will be in the selected color. 

Making You 

See Red 

Just about everyone knows that 
Googleõs the top dog when it comes to 

searching the Internet. But Google has 
some other functions you might find 
useful. You get to these other func-
tions by clicking on the more>> item 

at the top of the Google search results 
page. First, there is Google Earth 
which is discussed in the hidden treas-

ure item on page 2. Then thereõs the 
Local function that can be used to find 
businesses and services in your geo-
graphic area. Maps is also one of the 

Google tools. We donõt think itõs as 
useful as Map Quest, but if you want 
directions from point A to point B, itõll 

do. Froogal (frugal) shops the Internet 
for your selected item and gives you a 
list of sites and prices where that item 
can be found. Two other functions that 

you should experiment with are (1) 
Book SearchñSearch the full text of 
books (including copyright materials) 
and (2) Translateñallows you to view 

web pages in foreign languages. 

Little -

Known 

Google 

Features 
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unable to meet his essential living 

expenses (i.e., the fifth column from the 
left goes below 100%); and Cñis the 

point at which the Wife/Payee is able 

to meet 100% of her essential and 

nonessential living expenses (i.e., the 

rightmost column reaches 100%). The 

table suggests a potential range of 

annual spousal support from $13,338 to 

$26,676. The A, B & C designations are 
for illustration purposes and are not part 

of the program printout. The actual 

printed forms are print-shop perfect in 

spite of the fact that the facsimiles on 

this page become distorted in the reduc-

tion process. 

The Lifestyle form details the 

relationship between 28 different 
spousal support amounts and the 

parties' respective ability to meeting 

essential and nonessential living 

expenses. The 28 support orders range 

from zero to that amount of support 

required to equalize the parties' 

combined taxable income after taxes 
and including nontaxable incomeñthe 
third column from the leftñóChild 

Support.ó In the example from the Tuto-

rial in our manual, there are at least 

three interesting rows to take note of: 

Añis the point at which the Husband 

and Wifeõs incomes after taxes and 

exchange of child support are 
approximately equal; Bñis the point 

beyond which the Husband/Payor is 

C 

B 

A 
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One Hundred Plus  
 
Youôre in good company 
when you purchase our Re- 
vised Ohio Child Support  
Guidelines (WROCSG)  pro- 
gram. More than 100  
County Courts and Govern - 
ment Agencies use  
WROCSGðincluded are 
Domestic Relations Courts, 
Juvenile Courts, Probate 
Courts, Child Support En-
forcement Agencies, Depart-
ment of Human Services, 
Department of Job & Family 
Services, Prosecutorôs Of-
fices, Appellate Courts, Law 
Libraries and Universities 
throughout Ohio. So chances 
are pretty good that no mat-
ter where you practice, the 
Court or Agency youôre work-
ing with is using WROCSG. 
 
A recent enhancement to 
WROCSG is the use of an 
expanded support worksheet 
that provides all of the collat-
eral information required to 
perform a calculation. Weôve 
minimized the use of buttons 
and dialogs and all the infor-
mation they typically hide 
from the user. Instead, itôs all 
there like a magazine article 
containing sidebars. Easier to 
use and easier to under-
stand. 
 
So far as your printing 
choices are concerned, be 
assured nothingôs missing. 
You can still print an exact 
statutory version of the sole 
residential, shared parenting, 
or split parenting worksheets. 
And we still have the abbrevi-
ated or short form worksheet 
that puts everything you want 
on one sheet!  
 
Support Scheduler  
 
One ever-popular and useful 
extra is the arrearage calcu-
lator. It now does so much 
more than simply calculating 
arrearages that we call it the 
Support Scheduler . Its pur-

pose is to track support due 
dates and payments in order 
to provide a full and detailed 
rendering of the child support 
account from beginning to 
end. Organization is king . 
Calculating arrearages is 
made easier using built-in 
utilities that let you enter the 
terms of a support order and 
any number of modifica-
tions  so literally hundreds of 
transactions can be entered 
in one step. For example, if 
an obligor was ordered to 
make $400 payments 
monthly starting August 15, 
1991, you could simply enter 
those terms using the Sup-
port Order utility and the 
program would instantly 
provide you with a com-
plete account that details 
each and every payment,  
together with a running bal-
ance. Letôs further suppose 
that the obligor started mak-
ing payments in the begin-
ning but stopped making 
payments after July 1997. 
Weôve included another utility 
called the Payment Series 
that will allow you to enter the 
starting and ending dates of 
the obligorôs consecutive 
payments in order to itemize 
and calculate a running bal-
ance on a payment-by-
payment basis. Of course, 
you can insert, modify, delete 
and add individual entries 
anywhere in the schedule 
that you desire. 
 
Interested in Interest?  
 
WROCSG calculates statu-
tory interest on arrearages 
automatically. Furthermore, 
the entire child support ac-
count can be printed so that 
each support due date, each 
payment, and each item of 
accrued interest is clearly 
arranged.  

Features/Benefits  
 

¶ WROCSG is customized 

for Windows XP , but it 
runs in all 32-bit Windows 
operating systems (i.e., 
Windows 2000, Windows 
ME, Windows 98 and Win-
dows 95). 

¶ Youôll always be up-to-date 

on the latest law and pro-
gramming changes be-
cause WROCSG can 
download upgrades from 
the Internet 24 hours a 
day, seven days a weekð
and downloadable up-
grades are always free 
until a new major version is 
released.  

¶ The familiar look and feel 

of WROCSG will have you 
working like a pro the first 
time you run the pro-
gramðno learning curve, 
no training classes. Just 
type and go! 

¶ WROCSG now has the 
ability to send its output 
to your word processor 
in addition to your printerð
think of the possibilities, 
i.e., faxing, emailing, incor-
porating into documents, 
briefs, etc. 

¶ One mouse click lets you 
switch between the three 
statutory table lookup 

methods . 

¶ WROCSG automatically 

handles the calculation of 
minimum support orders 
for combined incomes in 

excess of $150,000 . 

¶ Easily perform program 

modifications like annually 
changing federal income 
tax dependency exemp-
tion on line 8 of the work-
sheetðwithout paying an-
nual subscription fees. 

¶ Extensive help information 

and relevant statutory cites 
are available via the ac-
companying help file. 

REVISED  OHIO  
CHILD  SUPPORT  GUIDELINES  


